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Newsgroups and News

Subscribing to Newsgroups and Retrieving News
In this chapter you will learn:

▼ How to subscribe to newsgroups.

▼ How to check for news.

▼ How to open and read news articles.

▼ How to display and hide newsgroups in the folder tree.

▼ How to create and modify news folders.

▼ How to post to a newsgroup.

▼ How to reply to an author.

▼ How to manage and store news articles.

Getting Starting
A newsgroup is a collection of articles on a specific topic. Articles can be 
newspaper articles, scholarly papers, general information, messages to the 
group, or someone's response to an earlier article. 

If you have learned how to create, send, retrieve and read mail with QMC you 
already know 90% of what you need to know in order to subscribe to 
newsgroups and retrieve news. The news-related operations use most of the 
same commands and steps as the mail-related operations. There are only a few 
more steps to take, which are described in this chapter.

To read newsgroup news, you must:

▼ Subscribe to an existing newsgroup.

▼ Retrieve articles within that newsgroup from the server.

For some examples of newsgroups and more information, see 
“Usenet: Internet News and Newsgroups” on page 100.
enter  ◆  173



               

Magid  Page 174  Thursday, November 9, 1995  5:44 PM
▼ Open the articles you download.

Subscribing to a Newsgroup
There are currently more than 10,000 newsgroups, and new ones are added 
every day. You can subscribe to any number of newsgroups that interest you 
and then download articles within that newsgroup, as long as you have enough 
disk space. Subscribing simply means selecting a newsgroup and placing it on 
a list of newsgroups that QMC will check for you on a regular basis. Within 
QMC, newsgroups you subscribe to display on the tree in the News branch, 
and have a distinctive icon to differentiate them from folders.

Figure 68: News Branch with Folders and Newsgroups

Obviously, you would not want QMC to automatically check and download 
articles from all 10,000 newsgroups on a regular basis. Subscribing offers you 
the opportunity to choose newsgroups which interest you. You cannot read 

 You should also create your own folders within the News 
folder in order to organize your newsgroup subscriptions, but 
you do not need to create these folders to get started. This is 
explained in “Creating New News Folders” on page 182.
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news until you subscribe to a newsgroup, but QMC does start you out by 
including a few newsgroups in the News branch of the tree. You can use these 
to get started, or subscribe to others right away.

To subscribe to a newsgroup, you will have to find out which newsgroups are 
available on the news server (or servers) to which you have access; news 
servers only carry a portion of the available news groups. The first time you 
subscribe you will spend a little extra time to download the list of newsgroups.

To subscribe to a newsgroup:

1 Click the News folder.

2 Pull down the Folder menu and select Newsgroups.

The Newsgroup dialog box opens and you can select the 
newsgroup to add. The Table below explains the options in this 
dialog box.

Figure 69: Newsgroup Dialog Box

The Newsgroups dialog box contains these options:

News Server Lists the available news servers.

Add Opens the Add News Server 
dialog box where you can enter 
the name of a news server to add 
to your list.
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3 Select a server from the News Server drop down list.

The first time you open this dialog box, you will have to 
retrieve the list of newsgroups on the selected news server. 
There is no other way to know which news groups are 
available.

4 If this is the first time you have subscribed to newsgroups on 
this server, click Retrieve List to display the list of the server’s 
newsgroups. If you have subscribed to newsgroups on this 
server before, skip this step.

5 When the list is retrieved, click a newsgroup in the Newsgroup 
list box, then click Subscribe. Begin typing the name of any 
newsgroup to scroll the list to that name. You may have to 

Delete Removes the selected news 
server from the list.

Newsgroups Lists newsgroups you can 
subscribe to on the selected 
news server.

Subscribe Adds the selected Newsgroup to 
the tree.

Retrieve List Refreshes the list of newsgroups 
on the selected News Server.

Show Tree/Hide Tree Shows or hides the News branch 
of the tree.

News Folder The selected newsgroup is added 
to the highlighted folder. You can 
select any folder in the tree.

Unsubscribe Removes the selected 
newsgroup from the folder tree.

There may be hundreds or even thousands of newsgroups on 
the news server, so it is possible that retrieving the list may take 
several minutes.
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guess that a particular news group will be interesting by its 
name. Later, you can remove the group if you find you are not 
interested in it. 

6 Repeat this step to subscribe to additional newsgroups.

7 Click Close in the Subscribe to Newsgroup dialog box.

The newsgroups you subscribed to will be added to the News 
branch in the selected folder.

Checking News
Once you have subscribed to newsgroups, you will want to check those 
newsgroups for new articles, and if there are any, download them to your 
computer. You can check a single newsgroup, all newsgroups you have 
organized within one folder, or all the newsgroups you have subscribed to. 

To manually check for news:

1 On the folder tree, click the newsgroup you want to check or 
click any folder on the News branch to retrieve news for all 
newsgroups in that folder.

2 Choose Check Selected News from the Connect menu or 
choose Check All News from the Connect menu to check all 
newsgroups at once.

Quarterdeck Message Center establishes an Internet 
connection and downloads new articles (articles you have not 
previously downloaded) from selected newsgroups. When the 
process is complete, a message box displays with the number 
of new articles. New articles within the selected newsgroups 
are then shown in the message list.

If you know the exact name of the newsgroup, you can type it 
in the Newsgroup text box.

You can also subscribe to a newsgroup using a pop-up menu; 
for information see the online help.
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Reading News
When you highlight a newsgroup in the folder tree the list of articles in that 
newsgroup displays in the message list on the right. The list contains:

▼ New articles which you have recently downloaded (see the 
previous section).

▼ Articles you have retrieved before but not read.

▼ Articles you have retrieved and read but not deleted. Once you 
read articles, they display in a non-bold font in the list.

Figure 70: Newsgroup Articles

To read any article:

1 Double click the message line for that article to open the 
Message window if the full body of the article has been 
retrieved, or select the article and pull down the Message 
menu and select Open. 

If only the article header has been downloaded and you are 
offline, this will mark the article for retrieval the next time you 
are online.
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2 Choose Next or Previous on the toolbar or from the Message 
menu to read the next or previous article in the list.

Downloading News Headers
You may find that you spend time downloading news articles, only to discover 
you have downloaded many articles in which you have no interest. If this is the 
case, you may find it beneficial to download only news headers, which take 
little time to download, instead of entire articles.

If you retrieve only the news article headers, you can browse through the 
headers in the message list area of the mailbox and determine which articles 
you want to read. If you are online, you can immediately download the full 
message and read it.

To download only message headers when you check for news:

1 Pull down the Tools menu and select Preferences.

The Preferences dialog box displays.

2 Click the News tab.

The news-related options display on this tab.

See “Downloading News Headers” on page 179 for 
information on downloading only news headers.

Once you retrieve articles, the procedures for reading 
them, displaying attachments and deleting them are 
identical to those for e-mail messages.

 For more information, refer to Chapter 12 on page 127.
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Figure 71: Preferences Dialog - News Tab

3 Select Retrieve Only Headers when Checking News.

4 Click OK.

To download an article when only the header has been retrieved (and you 
are offline):

 ◆ Click the Mark button, or double click the message in the 
message list or highlight the message you want to retrieve and 
choose Mark for Retrieval from the Message menu.

If you double click and you are online, the article is 
downloaded immediately and opens in the Message window. If 
you are not online or if you use one of the other methods, the 
body of the article is downloaded the next time you check 
news.

To retrieve the article you have marked:

 ◆ Pull down the Connect menu and select Retrieve Marked.

You can also retrieve a marked message using its pop-up 
menu; for information see the online help.
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Displaying and Hiding Newsgroups in the Folder 
Tree

You can hide the display of individual newsgroups you subscribe to on the tree, 
in order to maintain a less cluttered tree display. You do not need to display 
newsgroups to check news. You can organize newsgroups into common 
folders and check news by selecting a folder. When newsgroups are not 
displayed, the articles for all the newsgroups in each folder display together 
within the folder, instead of within the individual newsgroups.

To prevent newsgroups from displaying in the folder tree:

 ◆ Pull down the View menu and select Show Newsgroups to 
deselect it or click the - button to the left of the News folder.

When Show Newsgroups is not checked, only the folders 
which contain the newsgroups are displayed, even if the folder 
tree is fully expanded.

You can reverse the process to display newsgroups in the tree at any time.

To display newsgroups in the folder tree:

 ◆ Pull down the View menu and select Show Newsgroups to 
select it or click the + button to the left of the News folder.

Show Newsgroups is checked. Each individual newsgroup 
displays in the folder tree when the tree is expanded.

To check news when newsgroups are not displayed:

1 Click any folder on the News branch.

2 Pull down the Connect menu and select Check Selected News.

See “Expanding and Collapsing the Folder Tree” on page 148.

You can also check selected news using a pop-up menu; for 
information see the online help.
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Creating New News Folders
You can create new folders in the News branch of the tree in order to store and 
organize newsgroup subscriptions and articles.

To create a new folder in the News branch:

1 In the News branch of the tree, click the folder in which you 
want the new folder placed.

2 Pull down the Folder menu and select New.

The New News Folder dialog box displays. The options are 
described in the table that follows Figure 72 on page 182.

Figure 72: New News Folder Dialog Box

Folder Name Lets you enter a name for the 
new folder. The name may be up 
to 64 characters long. The folder 
will be added to the tree within 
the currently selected folder.

Newsgroup 
Subscriptions 

Shows the list of newsgroups 
which will be included in the 
folder. Use the Newsgroups, 
Properties and Delete buttons to 
create this list.
182  ◆  Chapter 15: Newsgroups and News



Essential Internet

Magid  Page 183  Thursday, November 9, 1995  5:44 PM
3 Enter a name for the folder in the Folder Name text box. 

The folder will be added to the tree within the currently 
selected folder.

4 Click the Newsgroups button.

The Newsgroups dialog box displays.

5 Click a newsgroup in the Newsgroups list box, then click 
Subscribe. Scroll the list to see all the newsgroups on the 
server.

6 Repeat step 5 as many times as you like to subscribe to 
additional newsgroups.

7 Click Close in the Subscribe to Newsgroup dialog box.

The newsgroup you subscribed to is added to the News branch 
in the selected folder.

8 Click OK in the New News Folder dialog box.

Newsgroups Opens the Subscribe to 
Newsgroup dialog box, where 
you can select newsgroups to 
add to the new folder.

Properties Opens the Newsgroup 
Properties dialog box where you 
can change the server that QMC 
will check for the selected 
newsgroup, or change the 
number of the last article read.

Delete Removes the selected 
newsgroup from the list.

When you add a folder to the News branch of the tree, you can 
also subscribe to newsgroups so that the articles from those 
newsgroups will be placed in the new folder. Steps 4 through 7 
tell you how.
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The new folder is added beneath the current folder and 
contains any newsgroups you selected.

Modifying a News Folder
You can change the name of a folder you have created on the News branch of 
the tree and easily add or delete newsgroup subscriptions within a folder.

To rename a News folder:

1 Select the folder in the folder tree.

2 Pull down the Folder menu and select Properties.

The Folder Properties dialog box opens.

Figure 73: Folder Properties Dialog Box

3 Delete the current name from the Folder Name text box, then 
type the new folder name.

If the selected folder is on the News branch of the tree, you 
can also modify the list of newsgroup subscriptions with the 
Newsgroup, Properties or Delete options.

You can also create a new news folder using a pop-up menu; 
for information see the online help.
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4 Click OK.

Modifying a Newsgroup Subscription
If you have access to more than one news server, you may want to retrieve 
articles from a newsgroup you currently subscribe to on a different news 
server. For example, if one news server becomes unavailable, you can check 
another news server for existing newsgroup subscriptions.

To modify a newsgroup subscription:

1 Select the newsgroup in the folder tree.

2 Pull down the Folder menu and select Properties.

The Newsgroup Properties dialog box opens. See the table 
following Figure 74 for more information on these options.

Figure 74: Newsgroup Properties Dialog Box

You can also modify a folder using its pop-up menu; for 
information see the online help.
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3 Select a different server from the News Server drop–down list. 
so QMC will check this alternate server when it retrieves 
articles.

4 Enter a different number in the Last Retrieved Message text 
box to begin downloading messages from a different starting 
number in order to bypass earlier messages and download 
only recent messages.

5 Click OK.

Newsgroup The name of the newsgroup 
selected in the folder tree.

News Server The name of the server you want 
QMC to connect to when it 
checks for new articles in the 
newsgroup.

Last Retrieved 
Message 

The number of the last message 
or message header that you 
downloaded.

First message The first message in the 
newsgroup available on the 
server.

Last message The last message in the 
newsgroup available on the 
server.

Reset Changes the number in the Last 
Retrieved Message box to 0 
(zero), so all messages in the 
newsgroup can be downloaded, 
even if they have previously been 
downloaded.

 You can also modify a subscription using a pop-up menu; for 
information see the online help.
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Updating a Newsgroup List
Newsgroups and news servers are constantly changing. If it has been a while 
since you first subscribed to newsgroups on a particular server there may be 
additional groups on that server. You may wish to display the most recent list 
of newsgroups on the server before choosing one or more newsgroups to 
subscribe to so you can see the most recent list of available newsgroups.

To update the list of newsgroups on a server at any time:

1 Click any folder in the News branch of the tree.

2 Pull down the Folder Menu and select Newsgroups.

The Newsgroups dialog box opens.

Figure 75: Newsgroups Dialog Box

3 Click Update List to update the list in the list box.

4 Select either of the options in the dialog box.

5 Once you have updated the list, you can double click any 
newsgroup in the list to add it to the current folder.

6 Click Close to close the dialog box.

Posting to a Newsgroup
To post your own article or message to a newsgroup, use the same steps you 
would use to compose a message.
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To post to a newsgroup:

1 Click the Compose button on the toolbar or pull down the 
Message menu and select Compose. 

The New Message window opens.

Figure 76: New Message Window

2 Click the Address Book button, then click the Newsgroups tab 
to bring it forward.

3 Highlight any newsgroup in the list and click the To button, 
then click Close.

If you know the exact name of the newsgroup, you can also 
begin typing it in the To text box. If it is in your newsgroup 
database, QMC will complete the newsgroup name for you.

4 Click in the Subject text box, then type the subject of your 
message.

The fields in this window were described in Table 3 on 
page 116.
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5 Click below in the message area (the large blank area in the 
bottom half of the window) and type the body of your 
message. QMC supports most standard Windows editing keys.

6 When you finish typing the message, click the Send button or 
pull down the Message menu and select Send.

The New Message window closes and the message is placed in 
the Outbox folder. The message is not sent from the Outbox 
until you choose one of the Send commands from the Connect 
menu, unless you are already online.

7 Pull down the Connect menu and select Send Messages.

This message and any other messages previously created and 
in the Outbox are sent.

Replying to an Author
Sometimes you may want to send a private message directly to the author of 
an article, instead of posting the message publicly to the newsgroup. You can 
reply to the author of an article in the same way as you reply to a message.

To reply to an author when the Message window is open:

1 Click the Reply button on the toolbar or pull down the Message 
menu and select Reply.

The Reply dialog box displays so you can specify options for 
this message.

Figure 77: Reply Dialog Box
Quarterdeck Message Center  ◆  189



Magid  Page 190  Thursday, November 9, 1995  5:44 PM
2 Click Reply to Poster to select it. This will remove the 
newsgroup name from the list of recipients.

The New Message window opens and the author’s name and 
address are automatically placed in the recipient list. The 
Subject field is also filled in.

3 Click in the message area and type your message.

4 Click the Send button or pull down the Message menu and 
select Send.

The New Message window closes and the message is placed in 
the Outbox folder.

Managing and Storing Articles
Since all articles are initially placed in the newsgroup from which they were 
retrieved, you may want to move some of them to another folder you have 
created for certain categories of articles. You can move selected articles to 
another folder, using the same techniques you use for moving messages. In 
fact, the procedures for copying, deleting and saving newsgroup messages as 
files are identical to those for e-mail messages.

To move one or more articles:

1 Select all the articles to be moved in the message list.

2 Pull down the Message menu and select Move.

The Move Message dialog box displays. 

You can also reply to an article using its pop-up menu; for 
information see the online help.

If you have only downloaded message headers, you cannot 
move or copy headers to another folder.

 See “Selecting Messages” on page 149 for steps to select 
multiple messages.
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Figure 78: Move Message Dialog Box

3 Enter the destination in the Destination Folder text box, or use 
the mouse pointer to click the destination in the folder tree.

4 Choose OK.

To move articles with drag and drop:

1 Select one or more articles in the message list.

2 Press and hold the mouse button over one of the selected 
article's icons. Then continue holding down the mouse button 
while you move the mouse pointer to a folder.

A confirmation dialog box displays during a move operation if 
you have the Confirm on Drag and Drop Copy/Move message 
option checked in the Preferences dialog box, Confirmation 
tab.

3 Choose Yes.

You can also move an article using its pop-up menu; for 
information see the online help.
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